
Skydive Planner Help Contents

Skydive Planner is a computer program that gives the relative work enthusiast the 
opportunity to design and plan skydives using a Windows-based personal computer.    
Skydive Planner also has a built-in 4-Way Draw Wizard which randomly draws 
intermediate or open rounds from an updateable divepool, saves the rounds for printing 
or editing, and saves a draw summary text file.    

Skydive Planner is totally intuitive--simply click on the item you need from the toolbar 
and drag it into place.    Or, right click on the design area where you want an item and 
select it from a pop-up tools menu.

-    Jumpers can be one of eight colors from the palette
-    4-way dives are automatically generated and the 4-way divepool can be color-coded 
to indicate individual slots
-    Once created, individual jumper colors can be changed at any time using the right 
mouse button--or group colors changed by bounding and double-clicking
-    Skydives can be printed in color or black and white (REGISTERED version)
-    Right, left, and either-direction rotations from 90 to 540 degrees can be selected
-    Straight arrows can be created, moved, and stretched to any orientation
-    Labels can be built and placed anywhere in the skydive
-    Groups of objects can be bounded, moved, copied, cut, or deleted
-    Skydives can be saved, reloaded, and edited(REGISTERED version)

Skydive Planner allows experienced and beginning organizers to capture and design 
skydives on their PC and arrive at the dropzone with color print-outs ready to jump.    4-
way teams and meet organizers can use the 4-Way Draw Wizard during training and 
for generating competition rounds.    Skydive Planner can also be used to to create 
your own digital logbook.    Be imaginative!    Have fun!

Menu Commands
Planning a Skydive
Saving
Printing
Registering



The re-sizable white area below the toolbar used for designing your skydive



Toolbar includes 8 jumper orientations, right rotations, left rotations, arrow tool, 
bounding tool, palette, and label maker



 Type the label, click the ab button, and drag the label into place.



 Select right and left rotations from 90 to 540 degrees (either-direction 
rotations are accessed under the tools menu).



 Click the palette to assign the color to a jumper you want to create.  
Once created, right click a jumper if you want to change its color.



Menu Commands

Click the toolbar controls and menu commands you want to know more about.

File
New
Open Jump
Open Summary
Save
Save As
Print 
Exit
Previous Files

Edit
Cut
Copy 
Paste 
Delete

Tools
Jumper
Right Rotations 
Left Rotations
Either Rotations
Arrows
Erase Labeler
View Toolbar
4-Way Draw Wizard

Colors (Pop-Up)
Help

Help File
Registration Information
Enter Registration Code
About



Colors Pop-Up Menu

To access the Colors Pop-Up Menu, right click on a jumper and then select the desired
color.    Select Delete if you want to delete the jumper.    You can also right click on 
rotations, straight arrows (in the center), or labels and individually Delete them.

These are the options in the Colors Pop-Up Menu:

Delete
------------
Red
Gray
Blue
Cyan
Yellow
Magenta
Black
Green

As you can see, these color selections are the same as the colors available in the 
palette.

Menu Commands



Help Menu

Help File
Select the Help File from the Help Menu or by pressing F1 at any time.    Make use of 
the Help File Options such as Keep Help on Top in the Help File menu bar.

Registration Information
This command provides information on how to register Skydive Planner.    
Registration is $17 U.S.    If you do not register, you will not be able to print or save 
skydives.

Enter Registration Code
This command calls up the Registration Name and Registration Code entry form.    
Enter the Registration Name and Registration Code information exactly as it is 
emailed to you and click OK.    You will see a personalized Thanks For Registering 
message box, will be entitled to email help, and, most importantly, will be able to print 
and save your skydives.

About
Check out the About menu item in Skydive Planner!



Skydive Planner

by Pyroware and Eric Bjorn
http://members.aol.com/skyplan
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Tools Menu

The Tools Menu can be accessed at any time from the menu bar or a Pop-Up Tools 
Menu can be accessed by right-clicking the design area whenever there is 1) no 
bounding box present or 2) a copy or cut command has not just been executed.    If case
1) or 2) exists, a right click will cause the Pop-Up Edit menu to appear.    If you do not 
want to use the edit menu, a right click, left click, right click will bring up the Pop-Up 
Tools Menu.

Click below to learn the functions of the Tools.

Jumper
Right and Left Rotations
Arrows
Bound Objects
Erase Label Maker
View Toolbar
4-Way Draw Wizard
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4-Way Draw Wizard

The 4-Way Draw Wizard randomly draws up to 10 rounds from the 4-way divepool that 
comes with Skydive Planner.    The 4-way block sequences and random formations are
kept as 40 individual .jmp files in the divepool directory and are randomly merged by the
4-Way Draw Wizard to generate intermediate- and open-class rounds.

NOTE:    It is important that you make a back-up copy of the divepool directory contents 
so you can replace any blocks or randoms that you inadvertently modify or delete.    It is 
also a good practice to avoid saving any other jumps in the divepool directory to reduce 
the chances of accidental changes to the divepool.    The divepool directory and its 
contents should be kept as a subdirectory of the directory that contains skyplan.exe.    
For example, if skyplan.exe is in the c:\skyplan directory, the divepool and its contents 
should be located at c:\skyplan\divepool.

On the other hand, with Skydive Planner, you can intentionally open jumps from the 
divepool directory and modify the jumper colors to reflect the slots you and your 
teammates fly or modify the jumps entirely when necessary to reflect updates to the 
current FAI divepool.    (In the divepool directory, the random formations A through Q are
saved as files 25.jmp through 40.jmp.)

Now on to the 4-Way Draw Wizard...You access the wizard under the Tools Menu or by
pressing F4.    

1.    Click the appropriate radio button to indicated whether you want an intermediate 
class or open class draw.    Click the -----> button to move forward in the wizard and the 
<----- button to move backward.    (For now, leave the QuickDraw checkbox unchecked.)

2.    Next decide if you want the rounds autosaved.    If you select Autosave each round, 
you will be asked for a root filename of six characters or less to which will be added the 
round number of each round drawn.    For example, if you type skydive for the root file 
name, only the first six characters will be used and the first round will be saved as 
skydiv01.jmp, the second round will be saved as skydiv02.jmp, etc., in the location 
you designate.    (Avoid saving your rounds in the divepool directory...use it only to store 
the divepool jumps.)    If you choose Prompt before saving in the 4-Way Draw Wizard, 
you will have the option to save each round after it is drawn.

3.    Next, decide if you want to save a draw summary.    The draw summary is a text file 
that lists the entire draw, round by round, and can be saved and printed.    If you select 
Yes, enter a filename in the file dialogue box and click OK.    After the draw is complete, 
you can view and print draw summaries by using the Open Summary command under 
the File Menu.



4.    Now you are ready to draw.    Click the Draw Round 1 button and the first round will 
appear in the design area and will be sumarized in the text box.    Click the Draw Round
2  button.    If you opted not to autosave, you will be asked if you want to save Round 1, 
otherwise it was saved automatically.    Continue for as many rounds as you need up to 
10.    You will be prompted to exit the draw after 10 rounds.    Click the Draw Finished 
button when you have drawn the rounds you need.

5.    Remember the QuickDraw checkbox on the first page of the wizard?    If you check 
it, the wizard will immediately advance to the draw page when you press the -----> 
button.    Rounds will be saved as round01.jmp, round02.jmp, etc., and the draw 
summary will be saved as summary.txt in the same directory as skyplan.exe.    Be 
careful--Quickdraw will overwrite existing rounds and summaries without warning.

6.    If you check the Randoms Only checkbox, 5 random formations will be drawn
for open class draws and 3 random formations will be drawn for intermediate class 
draws.    Only 3 total rounds of this type can be drawn for open and 5 for intermediate.

7.    Once you have completed the 4-Way Draw Wizard, you can open, edit, and print 
each round individually just like any jump.    You can also open and print the draw 
summary.

Tools Menu



Label Maker

The Label Maker allows you to create captions, notes, instructions, and comments for 
your skydive.    To use it, left click the mouse in the blank, white area of the Label Maker 
and you will get a flashing cursor.    Type in any text and when finished press the ab 
button.    The label will appear below the Label Maker in the Design Area.    Left click, 
hold, and drag the label into position.    Labels can be cut, copied, pasted, and deleted 
like any other object.    To erase the Label Maker select Erase Label Maker in the Tools
Menu or press Ctrl+E.

A couple of hints:

- Click the label in its center when you drag it--this will make positioning easier.    
To find the exact center, drag the label, un-click, then re-click--the mouse cursor will be 
positioned in the exact center of the label.    Now, click and drag into place.

- You must drag the label at least outside its original position.    If you need to 
tweak its position less than this amount, drag the label away, refer to the above hint, 
and retry the positioning.

Tools Menu



View Toolbar

Select or de-select this menu command to view or hide the Skydive Planner toolbar.

Tools Menu



Bound Objects Tool

The Bound Objects Tool allows you to group color change, move, copy, cut, or delete 
objects in the design area.

Click on the tool icon in the toolbar--the button will stay depressed and the mouse 
cursor will become a cross, OR you can simply click and hold anywhere in the design 
area, not on an object.    You bound objects by left clicking and dragging the mouse from
the upper left corner of the desired bounding area down to the lower right corner and 
then releasing the mouse button.    A dashed box will appear around the bound objects 
and the mouse cursor will return to a pointer.    The center of an object must be within 
the bounding box in order to be bounded.

Once bounded, you can drag the bound objects by left clicking and holding within the 
bounding box (but not on an object within the box) and dragging to the desired location 
in the design area.    Release the mouse button and the group will be re-positioned.    
Left click outside the bounding box to leave the drag mode.

Or, you can cut, copy, or delete bounded objects.

If you double-click bounded skydivers, a color pop-up menu will allow you to make a 
group color change.

Tools Menu



Arrows Tool

Arrows are very smart in this program.    To create an arrow click the arrow button on the
toolbar or press Ctrl+A.    The mouse cursor will become a cross.    Left click on the 
design area where you want the tail of the arrow and while holding the left button down, 
drag the mouse to where you want the head of the arrow and release the mouse.    The 
arrow is created.

You can reposition the arrow by left clicking and holding the middle of the arrow and 
dragging to the new position.    Release the left button and the arrow is moved.

You can re-size and re-orient the arrow by left clicking and holding the tail or the head 
and stretching or shrinking the arrow to the desired size and orientation. Release the left
button and the arrow is re-sized and re-oriented.

You can delete a single arrow by right clicking its center and selecting Delete from the 
pop-up menu.    You can delete all arrows in the current skydive by clicking the Tools 
Menu | Arrows | Delete All Arrows command.

Tools Menu



Right and Left Rotation Tools

Right and left rotations from 90 to 540 degrees can be selected and used in the design 
of the skydive.    Click on the desired rotation button on the toolbar and the rotation will 
appear below it. The rotation can then be dragged into position, cut, copied, or deleted.  
To select a different rotation value, use the menu bar or the Pop-Up Tools Menu to 
select right or left rotations and the desired degrees of the rotation.    The rotation button
in the toolbar will change its default to reflect the selected rotation value.

Either direction rotations of 180, 360, and 540 degrees can be selected under the Tools
Menu.

Tools Menu



Jumper Tool

A jumper can be created three ways.

1.    The first way is to click a jumper button on the toolbar.    A jumper will appear 
directly beneath the clicked tool and can then be dragged into place.    

2.    The second way is to use the Pop-Up Tools Menu.    Right click on the design 
area and select the desired jumper orientation.    The jumper will be placed at the right-
click location. 

3.    The third way is to click the Tools | Jumper menu in the menu bar and select the 
desired orientation.    A jumper will appear directly beneath the appropriate tool button. 
(This third way would probably only be used if the toolbar has been de-selected.)

The color of the jumper is determined by the color selected in the color palette.    Once
created, right-clicking on an individual jumper will bring up the Colors Pop-Up Menu 
and allow you to change the jumper color.

Tools Menu



To select the default jumper color, click the desired color on the color palette



Edit Menu

The Edit Menu can be accessed in the menu bar at any time, or a Pop-Up Edit Menu 
can be accessed by right-clicking the design area anytime there is 1) a bounding box 
present or 2) first thing after a copy or cut command has been executed.

Cut (Ctrl-x)
This command cuts any objects that have been bound using the bounding tool.    No 
more than 32 objects (unlimited straight arrows) and 8 labels may be cut at one time.   
After a cut command, the bound objects will disappear from the screen but are stored 
in a buffer.    They are available to paste either in the current skydive or in a new 
skydive.

Copy (Ctrl-c)
This command copies any objects that have been bound using the bounding tool.    No
more than 32 objects (unlimited straight arrows) and 8 labels may be copied at one 
time.    After a copy command, the bound objects will remain on the screen but are 
copied into a buffer.    They are available to paste either in the current skydive or in a 
new skydive.

Paste (Ctrl-v)
This command pastes any objects that have been cut or copied.    The pasted group 
will appear in the upper-left corner of the design area surrounded by the bounding 
box.    Left click and hold within the bounding box and drag to the desired location in 
the design area.    Release the mouse button and the group will be pasted.    Left click 
outside the bounding box to leave the drag mode.

Delete (or Delete key)
This command deletes any objects that have been bound using the bounding tool.

Menu Commands



File Menu

New (Ctrl-n)
This command clears the design area to start a new skydive. If any changes have 
been made in the design area when you select the New command, Skydive Planner 
asks if you want to save the changes. Skydive Planner then clears the design area.

Open Jump (Ctrl-o)
This command opens the directory tree so you can select a skydive (.jmp file) for 
editing. If any changes have been made in the design area when you select the Open 
command, Skydive Planner asks if you want to save the changes.    When you 
double-click the .jmp file in the directory tree, Skydive Planner opens the selected file
in the design area.

Open Summary
This command shells to notepad.exe and opens a draw summary text file which is 
created using the 4-Way Draw Wizard.

Save (Ctrl-s)
This command saves changes made to the skydive in the design area.    It brings up a 
directory tree for you to identify where you want the skydive saved.    If the Title bar 
shows that the skydive is untitled, the Save command will be disabled.    Instead, for 
your first save of a new skydive, use the Save As command.    Save and Save As 
commands are only available in the REGISTERED version.    See more on Saving.

Save As
This command saves the skydive in the design area.    The directory tree appears so 
you can make the initial save of a new skydive or so you can save an existing skydive 
with a different file name (make a copy of it).

Print (Ctrl-p)
This command allows you to print your skydive.    You may select color or black and 
white output and from one to eight copies.    Color output uses colored rigs to identify 
the jumpers while black and white output uses pre-determined ascii symbols.    If the 
Print Filename Header checkbox is checked, it will print the jump filename and path 
at the top of the printout.    The Print command is only available in the REGISTERED 
version.    See more on Printing.

Exit
This command closes the Skydive Planner.    If any changes have been made in the 
design area, Skydive Planner prompts you to either exit without saving or cancel the 
Exit command.
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Planning a Skydive

Planning a skydive is fun with Skydive Planner and will yield professional-looking 
results.    Here are a few random thoughts that may help you.

- Two example skydives were included in the files.    They are 4way.jmp and 16way.jmp. 
Take a look at them to get some ideas on how to design a skydive.

- Skydive Planner is best suited to 16-ways or fewer.    As you can see, there are only 8
jumper orientations--if you get much bigger than 16, you begin having more trouble with 
the angles.

- When you have a choice, choose the north, east, south, and west oriented jumpers--
they can be docked with less overlap than the diagonal-facing jumpers.

- Build a point in a clean section of the design area and then bound it and drag it in tight 
with the previous points--this will create a tighter, neater looking skydive.

- Once you have created a point once and saved it in any skydive, you will never have 
to build it again.    Simply open up the skydive with the point you want, bound it and copy
it, then open up your new skydive and paste it.    If you need to adjust the colors, right 
click the jumper and choose the desired color.    Or for a group color change, bound the 
group, double-click in the bound area, and select the new group color.

- Arrows are excellent for pointing out key aspects of a skydive (like line of flight or tricky
transitions) or to indicate the need for a piece to slide.

- Use lots of labels to clarify points and to serve as reminders--what seems clear to you 
now might not be so clear later.

- Positioning a jumper takes some practice--to display a proper dock may be a matter of
one pixel on your screen.    If you have trouble fine-tuning a dock, sometimes it helps to 
pull the jumper away from the formation and try re-docking.    (Sounds like the real 
thing!)

- The divepool blocks are built slot perfect as layed out in the FAI divepool    If you are 
organizing a meet, there should be no need to change any colors.    If you are drawing 
4-way rounds for training purposes, change the divepool colors to reflect the slots you 
and your teammates would most likely fly.    For other organizing, take full advantage of 
the available colors.



Saving a Skydive

Save and Save As commands are only available in the REGISTERED version.

A skydive is saved as a simple text file and has the extension .jmp. It can therefore be 
easily attached to an email and shared with friends.    If you have a favorite dive send it 
to Eric Bjorn at bjorneb@aol.com to be included in the growing collection of hot 
skydives from around the world on the HOT RW website 
(http://members.aol.com/bjorneb/hotrw.htm).

Notes on Saving:

- When asked for a filename, you can type it with or without the .jmp extension--
Skydive Planner will add the extension for you, if needed.    

- When you have changed or moved any objects in the design area since the last save 
and want to create a new skydive, open an existing one, or exit the program, Skydive 
Planner will ask you if you want to save the existing skydive.



Printing a Skydive

Printing can be done in color or black and white.    To print in color, click the Color radio 
button on the Print dialogue box.    Due to limitations of the built-in Windows printing 
system, the jumpers in color print-outs will not be colorized from head to toe.    Instead, 
each will have an easily discernible color mark (rig) printed on it.

When printing in black and white, click the Black and White radio button on the Print 
dialogue box.    Ascii symbols will be printed on the backs of each jumper.    (One of the 
challenges of designing this program was finding the ascii symbols small enough to fit!)  
Each jumper will print with the corresponding ascii symbol shown below:

Red - (+)
Gray - (x)
Blue - (o)
Cyan - (s)
Yellow - (z)
Magenta - (a)
Black - (v)
Green - (e)

You can print from 1 to 8 copies by adjusting the number using the up and down arrows 
in the Print dialogue box.



 Color print example



 Black and white print example



Registering Skydive Planner

Unless you register, you will not be able to save or print skydives you design yourself or 
generate automatically using the 4-Way Draw Wizard. You will also be frequently 
reminded that you have the unregistered version whenever you do try to save or print 
files.    Registration is inexpensive, easy, and necessary to fully enjoy the capabilities of 
Skydive Planner. 

By Credit Card 

You can register Skydive Planner using any major credit card. You will be emailed your 
personal registration code within 48 hours.    It's quick, it's easy, and it's secure!    To 
register on-line, go to the Skydive Planner Registration Web Site at

http://members.aol.com/skyplan/register.htm

and click on the DigiBuy image.    Follow the instructions to register using your credit 
card.

By Check or Money Order 

The file register.doc is provided with your Skydive Planner files--it is a registration form 
that doubles as an envelope. Print it using Microsoft Word v. 6.0 or other word 
processor, neatly fill in the necessary information (your email address), fold as 
indicated, enclose your payment of $17 check or money order, and tape the edges shut.
Put on a first-class stamp and mail it.    Your registration code will be promptly emailed to
you. (If you want your registration code via U.S. Mail, please add $1.50 for postage and 
handling.)      

Or if you prefer, print and fill out the order form register.txt, address your own envelope, 
and send your Registration Name (at least five characters), payment, and email address
(or U.S. Mail address) to: 

                                  Skydive Planner
                                  336 Cottonwood Place
                                  Beavercreek, OH 445440 

Receiving Your Registration Code 

Watch your email. You will soon receive your Registration Code and a confirmation of 
your Registration Name. Copy them down and put them in a safe place. If you ever 
need to re-install Skydive Planner OR UPGRADE, you will need the Registration Name 
and Registration Code. 



Registering 

Enter your Registration Name and Registration Code under the Skydive Planner Help 
menu exactly as printed in the email. Click OK. Congratulations, you are now a 
registered user!

Eric Bjorn
bjorneb@aol.com

Web Site:    http://members.aol.com/skyplan




